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Overview 
The application tuning parameters can be used to optimize performance and enhance functionality.  

1. Each building block has its own tuning parameters which can be accessed by right clicking its 
container in the All Containers section in the Application Studio and selecting Properties from 
the displayed popup menu. For example, right clicking Alarms and selecting Properties from 
the popup menu, displays the Alarms Properties dialog box. 

Each field in the dialog box represents an alarm tuning parameter.  
When a change to a tuning parameter in the Properties dialog box of a specific building block is made, 
it is reflected in the wiztune.dat file located in the c:\application\proj directory. Parameters that were 
not displayed in the file before being modified are displayed after modification. 
You can access the wiztune.dat file and change an entry back to the application default. You can also 
tune a parameter directly into the file. 
The following is a list of all the application tuning parameters, their locations, default values and the 
field they represent in the containers Properties dialog box.  Also defined is whether a change can be 
defined online or if the application should be restarted for changes to take effect.  

Note:  The wiztune.dat file is used to add tuning parameters to an application. Certain 

parameters can change the behavior of the application or its features.The wiztune.dat file is 

saved in the application's folder and is an integral part of the application.  

 

Accessing the Wiztune.dat File 
More than one way can be used to access this file. 

�  To access the Wiztune.dat file, do the following: 

In the Application Studio All Containers pane right click the application name and select Open Tuning 
Parameters File.  The Wiztune.dat file will open in Notepad on your screen. 
Or, 
In the application folder create a Wiztune.dat file and then open it using a text editor. 

  

WIZTUNE.DAT 

The changes you make in the Tuning Parameters are recorded in the WIZTUNE.DAT file. This file 
contains all of the application environmental parameters and their current values. 
The WIZTUNE.DAT file is an ASCII file that can be edited using any text editor.  
The following is an example of the WIZTUNE.DAT file 
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************************************************************ 

; FILE: WIZTUNE.DAT                                          

; APPLICATION ENVIRONMENT DEFINITION FILE                              

; All atoms can be dynamically changed and retrieved by:          

; WizGetEnv() and WizSetEnv() APIs.                               

;*********************************************************** 

;*********************************************************** 

; Syntax:                                                         

; Lines that start with ";" are comments, empty lines are         

; ignored. Lines without the character '=' are also ignored.      

; Spaces before/after the '=' sign are not significant.           

;********************************************************** 

;*********************************************************** 

; Limitations:                                                    

; 1. Total number of lines (ALL lines) in the file is                 

;   limited to 200.                                              

; 2. The name of an environment variable is limited to 32         

;   characters.                                                  

*;********************************************************* 
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;=================== Manager Variables ==================== 

; Automatic recover to last state after crash (power 

failure, etc.) 

; Default is NO. 

AUTORESTART=YES 

; Default user when starting APPLICATION 

; Format is User.Password or "*" for last user. 

; Default is "No User". 

; For example: 

DEFAULTUSER=hello.world 

; Put APPLICATION in the system task list? 

; Default is YES. 

INTASKLIST=YES 

 Login & Logout alarm text. 

; If missing, the corresponding alarm will not be 

generated. 

; $U represents the current user name. 

LOGIN_TEXT=$U logged-in. 

LOGOUT_TEXT=$U logged-out. 

: Determine if a message will appear after you made changes 

in 

; a layout and then exited. 

; Default is YES. 

ASKSAVELAYOUT=YES 

; Determine if the done-bar will appear for a large job 

execution. 

; Default is YES. 

SHOWDONEBAR=YES 
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=================== Image VP Variables ===================== 

; Image update rate, in milliseconds. 

; Defaults are: MinWait=10, MaxWait=2000. 

IMGMINWAIT=10 

IMGMAXWAIT=2000 

; IMG: size of (collapsed) buffer for receiving msgs from 

WizPro. 

; Must be in the range 5 to 500 (default is 100). 

IMGWIZMSGBUF=100 

; Define object blink rate parameters (fast, medium, slow). 

IMG_BLINKRATES=500 1000 2000 

; Determine if trigger object will be highlighted when 

selected. 

; Default is NO. 

TRG_FEEDBACK=NO 

; Determine if clicking on overlapping triggers will 

activate 

; the top or bottom object. Default is TOP. 

TRG_ACTIVATE=BOTTOM 

;============== Event Summary VP Variables ================= 

; Event Summary action when double-clicking on alarm. 

; Can be ASSIST or ACK. Default is ASSIST. 

ANN_DOUBLE_CLICK=ASSIST 

;==================== WizPro Variables ===================== 

; WizPro Logger flush rate, in seconds (historic files.) 

; Default is 30, maximum is 3600. 

LGRFLSHTIME=30 

; WizPro Logger buffer size, in lines (records) (historic 

files). 
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; Default is 124, maximum is 2048. 

LGRBUFSIZE=124 

: Alarm generator will not generate new alarms while 

condition is TRUE 

; and alarm is force-ended (or auto-ended), if this variable 

is 

; set to YES. (Default is NO). 

ALGEN_REGARD_STATE=NO 

; WizPro will load this recipe, at startup. 

STARTUP_RECIPE=LOADME.1ST 

; ALARM_PRT_CONDENSE contains the escape sequence sent to 

printer 

; before each alarm. Consists of decimal ASCII codes 

separated by commas. 

; For example, if the code ESC 7 (digit 7, ASCII 55) is to 

be sent, 

; use ALARM_PRT_CONDENSE=27,55. If the variable is not 

defined, 

; ASCII 15 (<Ctrl>O) is used. To suppress any condense 

character 

; before alarms, use "ALARM_PRT_CONDENSE=". 

; ALARM_PRT_2_LINES - if YES is specified, alarm printing 

will be 

; divided into two lines, with alarm text on the second 

line. 

ALARM_PRT_CONDENSE=15 

ALARM_PRT_2_LINES=NO 
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Wiztune.dat Parameters 
The following are application parameters and the values that they can receive. 
 

AAM_ACTIVATE  

Keywords AAM Alarm 

Purpose Define if Advanced Alarm Management is enabled 

Value Type Enumerated 

Default Value  NO 

Value 1/ min NO 

Value 2/ min Yes 

Via Application 

Menu  

Station Properties / Advanced Alarm Management 

Restart required Yes 

AAM_ENABLE_PRIORITY_MANAGEMENT 

Keywords AAM priority 

Purpose Define if priority management is enabled for AAM. It 

will use severity of alarm to define priority call 

according  to the 

AAM_PRIORITY_MANAGEMENT_HIGHEST_SEVERITY 

Value Type Enumerated 

Default Value  NO 

Value 1/ min NO 

Value 2/ min Yes 

Via Application 

Menu  

Station Properties / Advanced Alarm Management 
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Restart required Yes 

AAM_PRIORITY_MANAGEMENT_HIGHEST_SEVERITY 

Keywords AAM priority 

Purpose Define the rule for AAM priority. If Yes, Highest 

priority is highest severity. If No, Lowest severity is 

highest priority 

Value Type Enumerated 

Default Value  NO 

Value 1/ min NO 

Value 2/ min Yes 

Via Application 

Menu  

Station Properties / Advanced Alarm Management 

Restart required Yes 

ALERT_END_USER_ABOVE_ACK 

Keywords Alarm event 

Purpose Enables the Force End operation in the User field of 

the Events Summary (displaying which user ended 

or acknowledged an Alarm) 

Value Type Enumerated 

Default Value  NO 

Value 1/ min NO 

Value 2/ min Yes 

Via Application 

Menu  

Events Summaries -> (right) Properties -> General -

> Show Force End User 

Restart required Yes 



 
 
 
 
 
   

                                                                                 
   Wizcon

®
 Supervisor™ WizTune User Guide  

ALERT_PRT_CONDENSE 

Keywords Alarm event font format print 

Purpose Enables printer to print alarms in a smaller font 

Value Type  Text 

Value 1/ min  [ASCII code], [ASCII code],  … 

Value 2/ min  See Notes 

Notes ALERT_PRT_CONDENSE=27,55 sends the 

message “ESC 7”.  (In ASCII code 27-> ESC and 

55->7). 

Via Application 

Menu 

Alarms -> (right) Properties -> Printer -> Alarm 

printer escape sequence 

Restart required Yes 

ALERT_TIME_FORMAT 

Keywords Alarm date event format time 

Purpose Selects the day or date and time format for an alarm 

Value Type  Enumerated 

Default Value Day and Time 

Value 1/ min  See Notes 

Notes Four possible values (formats): DAY + TIME, DAY + 

TIME + MILLISECONDS, DATE + TIME, DATE + 

TIME + MILLISECONDS 

Via Application 

Menu 

Alarms -> (right) Properties -> Time Format 

Restart required Yes 

ALGEN_REGARD_STATE 

Keywords Alarm event 
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Purpose Prevents generation of new alarms if an alarm 

condition remains true and the alarm is defined as 

auto-ended 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min  Yes 

Via Application 

Menu 

Alarms -> (right) Properties -> General -> Avoid 

generating new alarms 

Restart required Yes 
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ANN_AUTO_SCROLL_TO_TOP 

Keywords Alarm event 

Purpose Causes Events Summary to scroll to top 

automatically to show new alarms 

Value Type  Enumerated 

Default Value No 

Value 1/ min No 

Value 2/ min Yes 

Via Application 

Menu 

Events Summaries -> (right) Properties -> General -

> Scroll alarm list 

Restart required Yes 

ANN_DOUBLE_CLICK 

Keywords Alarm event 

Purpose Obtains additional information (ASSIST) and/or 

acknowledges (ACK) an alarm upon double-clicking 

the alarm in the Event Summary. Alternatively, you 

can use the syntax, 

ANN_DOUBLE_CLICK=TAG=<<MY_TAG>> where 

MY_TAG is the name of your tag. If you do this, 

when you double click on an alarm, the alarm ID of 

the clicked alarm will be set as the value of 

MY_TAG. If you prefix the tag name with ACK_ not 

only will the alarm ID be set as the value, but the 

alarm will be acknowledged as well.  

Value Type  Enumerated 

Default Value ASSIST 

Value 1/ min  ASSIST 

Value 2/ min  ACK 

Value 3 min  ACKASS 
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Via Application 
Menu 

Events Summaries -> (right) Properties -> General -

> Alarm help text status. 

Note that the tag option is not available via the user 

interface. 

 Restart 
required 

No 

 

ANN_FONTSIZE 

Keywords Alarm event font 

Purpose Sets the font size for alarm titles, text and messages 

in the Event Summary 

Value Type  Numeric 

Default Value From system  

Value 1/ min  See Notes 

Value 2/ min  See Notes 

Notes The size limits depends on the font type. Backwards 

compatibility only. 

Restart required Yes 

ANN_FONTBOLD 

Keywords Alarm event font 

Purpose Whether the font for alarm titles, text and messages 

in the Event Summary is written in bold script 

Value Type  Numeric 

Default Value From system  

Value 1/ min  See Notes 

Value 2/ min  See Notes 
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Notes The size limits depends on the font type. Backwards 

compatibility only. 

Restart required Yes 
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ANN_FONTITALIC 

Keywords Alarm event font 

Purpose Whether the font for alarm titles, text and messages 

in the Event Summary is written in italic script 

Value Type  Numeric 

Default Value From system  

Value 1/ min  See Notes 

Value 2/ min  See Notes 

Notes The size limits depends on the font type. Backwards 

compatibility only. 

Restart required Yes 

 

ANN_STANDARD_PRINTING 

Keywords Alarm event 

Purpose Enable the file menu item, for printing event 

summary using standard Windows dialogs 

Value Type  Enumerated 

Default Value No  

Value 1/ min  NO 

Value 2/ min  Yes 

Via Application 

Menu 

Event Summaries ->(right) Properties -> General -> 

Standard Printing 

Restart required Yes 
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ANN_ALLOW_BLINK 

Keywords  Event Summary 

Purpose If set to yes, all alarms in the event summary that are 
not acknowledged or ended will blink 

Value Type        YES/NO 

Default Value NO 

Via Application 

Menu 

Event Summaries ->(right) Properties -> General -> 

New Alarms Blinking 

Restart required  NO 

 

 

ANN_HANDLER_NAME_BEFORE_ACK 

Via Application 

Menu 

Event Summaries ->(right) Properties -> General -> 

Handler name required 

 

 

ANN_ AUTO_SCROLL_TO_TOP 

Keywords  Event Summary 

Purpose If set to yes, all new alarms will cause the event 
summary to display the top line of the alarms, even if 

Keywords  Event Summary 

Purpose If set to yes, a user must enter a name into a dialog 
box before he can acknowledge an alarm 

Value Type        YES/NO 

Default Value NO 

Restart required  NO 
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the window has been scrolled 

Value Type        YES/NO 

Default Value NO 

Restart required  NO 

 

 
 

ASKSAVELAYOUT 

Keywords Layout 

Purpose Enable system to prompt to save the Layout before 

exiting the application  

Value Type  Yes 

Default Value Yes 

Value 1/ min  No 

Via Application 
Menu 

Layouts -> (right) Properties -> Prompt to save 

layout 

 Restart 
required 

No 
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ASSIST_HELP_BUTTON 

Keywords Alarm event 

Purpose Enables displaying the Help button on the ANN 

window for Events Summaries 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min  No 

Via Application 

Menu 

Events Summaries -> (right) New Events Summary -

> (highlight alarm) Operations -> Assist 

Restart required Yes 

ASSIST_PRINT_BUTTON 

Keywords Alarm event print 

Purpose Enables displaying the Print button on the ANN 

window for the Event Summaries 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min  No 

Via Application 

Menu 

Events Summaries -> (right) New Events Summary -

> (highlight alarm) Operations -> Assist 

Restart required Yes 
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AUDIT_TRAIL_DSN_NAME 

Keywords Audit 

Purpose Selects the name of the database file to hold the log 

data 

Value Type  Enumerated 

Default Value --- 

Value 1/ min  See Notes 

Notes Twelve possible values (file types): dBASE files,  

dBASE files - Word,  Excel files,  FoxPro files - 

Word, odbc_name    

Via Application 

Menu 

 Application -> (right) Station Properties -> Audit Trail 

-> Current Data Source 

Restart required No 

 

 AUDIT_TRAIL_ENABLE 

Keywords Audit database tag 

Purpose Enables logging operator actions in the form of tag 

values to an ODBC data source. 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Via Application 

Menu 

Application -> (right) Station Properties -> Audit Trail 

-> Enable Audit Trail 

Restart required No 
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AUTORESTART 

Keywords Start 

Purpose Enables automatic recovery to the last stable state 

after a system crash 

Value Type  Enumerated 

Default Value No 

Value 1/ min  Yes 

Value 2/ min No 

Via Application 

Menu 

Application -> (right) Station Properties -> General -> 

Auto Restart after an illegal shutdown 

Restart required No 

 

CHART_SCALE_EXTRA_WIDTH 

Keywords Chart 

Purpose Sets the width of the space containing the vertical 

scale for charts 

Value Type  Numeric 

Default Value 0 

Value 1/ min  0 

Value 2/ min --- 

Restart required Yes 
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CHR_MULTIMARKERS 

Keywords Chart 

Purpose Enables a different color for each marker (up to ten 

markers) for the "Line with marker" and "Marker 

only" type charts 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Via Application 

Menu 

Charts -> (right) Properties -> Multi Markers -> Use 

chart multi markers 

Restart required Yes 

 

CHR_SHOW_COMPRESSION_WARNING 

Keywords Chart 

Purpose Displays a warning message whenever data 

compression occurs for a chart 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 

 
 
 
 



 
 
 
 
 
   

                                                                                 
   Wizcon

®
 Supervisor™ WizTune User Guide  

CHART_REPORT_USE_SET_VALUES 

Keywords Chart 

Purpose Use set values during a communication error. 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Restart required Yes 
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COMMERR_TIMEOUT 

Keywords Wait 

Purpose Determines the time out (in seconds) due to a 

communication error 

Value Type  Numeric 

Default Value 30 

Value 1/ min  5 

Value 2/ min 180 

 Restart required Yes 

 

DEFAULTUSER 

Keywords Login start 

Purpose Enables selection of the user name for automatic 

login in application startup 

Value Type  Text 

Default Value --- 

Value 1/ min  User.password 

Notes Default requires user to supply password on login.  

Use * for last user. 

Via Application 

Menu  

Application -> (right) Station Properties -> Default 

User 

Restart required No 
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DRAW_EXCLUSIVE_RECT 

Keywords Image 

Purpose Draws a rectangle without a border  

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Notes This parameter is used for backward compatibility 

with OS/2. 

Restart required Yes 

 

 

DRV_TIMEOUT_FACTOR 

Keywords Wait 

Purpose Determines the driver timeout in milliseconds by 

adding 5000 ms to the value of this parameter. 

Value Type  Numeric 

Default Value 25 

Value 1/ min  0 

Value 2/ min 200 

 Restart 

required 
Yes 
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FULL_SECURE_LOGOFF 

Keywords Logout 

Purpose Reinstates full system security when the current user 

logs out of the system 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Restart required No 

 

HOTBACKUP_UPDATE_ALARMS 

Keywords Alarm backup 

Purpose Enables backup station to update online alerts from 

the master station 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

 Restart 
required 

Yes 
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HOTBACKUP_UPDATE_TAGS 

Keywords Backup tag 

Purpose Enables backup station to update tags from master 

station 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 

 

IMG_AUTOCALIBRATION_RATIO 

Keywords Image 

Purpose If IMG_DISABLE_AUTOCALIBRATION is set to No, 

new image are calibrated according to following 

parameter values. 

 

Using this parameter according to your display 

device ensures that your image will show no 

distortion in their coordinate system 

Value Type  strings 

Default Value 4:3 

Values 4:3 (normal screen), 5:4 (TFT screen), 16:9 (Wide 

screen) 

Notes Accesibl trough Images � (right click)Properties � 

Loading tab. 

Restart required No 

 
 



   
 
 
 
 

  Wizcon
®
 Supervisor™ Wiztune User Guide 

IMG_BLINKRATES 

Keywords Image 

Purpose Determines the blinking rate in ms for dynamic 

objects (ie the amount of time the object is visible) 

Value Type  Numeric 

Default Value 500 1000 2000 

Value 1/ min  100 

Notes Format: IMG_BLINKRATES=fast# medium# slow# 

Via Application 

Menu 

Images -> (right) Properties -> Dynamic -> Fast or 

Medium or Slow 

Restart required Yes 

 

IMG_CLUSTER_LEFT_DRAGDROP 

Keywords Image 

Purpose Enables drag/drop from cluster library using left 

mouse button 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Notes This parameter maintained compatibility between 

Windows and OS/2. 

Restart required Yes 
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IMG_CLUSTER_USE_LAYER 

Keywords Image 

Purpose Enables cluster to be used with layer support 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

 Restart 

required 
Yes 

 
 

IMG_CONVERT_LINE_TYPES 

Keywords Image 

Purpose Disable conversion of line types to new values 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 
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IMG_EXPAND_REFRESH_BOX 

Keywords Image 

Purpose Expands an object drawing box it is redrawn. This 

fixes object rendering when it overlaps its borders. 

Value Type  Numeric 

Default Value 2 

Value 1/ min  0 

Value 2/ min 20 

Notes This is especially useful for “old” texts created with  

versions of Wizcon before 9.0 

Restart required Yes 

IMG_DISABLE_AUTOCALIBRATION 

Keywords Image 

Purpose Auto calibration is used only on new image creation. 

It determines if an automatic ratio should be used for 

image internal coordinates system 

No = Allow autocalibration by using ratio given in 

IMG_AUTOCALIBRATION_RATIO 

Yes = disable 

Value Type  Enumerated 

Default Value No 

Value 1/ min  Yes 

Value 2/ min No 

Notes Accessible trough Images � (right click)Properties 

� Loading tab. 

Restart required No 
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IMG_EDIT_REFRESH 

Keywords Image 

Purpose Enables an image to be repainted automatically after 

editing operations 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Via Application 
Menu 

Images -> (right) Properties -> View -> Repaint 

images after editing operations 

 Restart 
required 

No 

IMG_FAST_ZONE_THRESHOLD 

Keywords Image 

Purpose Sets the maximum time interval (in milliseconds) to 

draw the background for a fast zone (i.e., drawing 

the background of a slow zone takes longer) 

Value Type  Numeric 

Default Value 2500 

Value 1/ min  0 

Value 2/ min 32000 

Via Application 

Menu 

Images -> (right) Properties -> Fast Zone -> Fast 

zone threshold 

Restart required Yes 
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IMG_FONT_H 

Keywords Font Image 

Purpose Controls the height of true type fonts 

Value Type  Numeric 

Default Value 1000 

Value 1/ min  14 

Value 2/ min 1000 

Notes This parameter applies to the Chinese and Japanese 

versions. 

Restart required Yes 

 

IMG_FONT_W 

Keywords Font Image 

Purpose Controls the width of true type fonts 

Value Type  Numeric 

Default Value 1000 

Value 1/ min  14 

Value 2/ min 1000 

Notes This parameter applies to the Chinese and Japanese 

versions. 

Restart required Yes 
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IMG_GRAD_STEP 

Keywords Image 

Purpose Determines the number of steps in the color gradient 

for images 

Value Type  Numeric 

Default Value 16 

Value 1/ min  2 

Value 2/ min 255 

Via Application 

Menu 

Images -> (right) Properties -> View -> Number of 

gradient color steps 

Restart required No 

 
 
 
 

IMG_HIGHLIGHT_ON_SELECTION 

Keywords Image 

Purpose Determines if the selected object is drawn in a 

contrasting color 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Restart required Yes 
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IMG_LOAD_BMP_AS_DIB  

Keywords Image 

Purpose Determine in which memory bitmap files are loaded 

Yes = Load in main memory 

No = Load in video memory (old version system) 

Value Type  Yes/No 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Via Application 

Menu 

Object by object through context menu ‘Tooltips’ 

Restart required No. Checked on image load. 

 
 

IMG_LOADING_ADDTOOLTIPS  

Keywords Image 

Purpose Enable or disable automatic tooltips add during 

image loading. 

Objects with tooltips won’t be changed 

Objects without any tooltip will be marked with tooltip 

value given in this tuning parameter 

Only dynamic objects, dynamic texts and clusters 

are concerned 

Value must be a binary combination of following 

numbers : 

- Show tag names (0x1) 

- Show tag description (0x2) 

- Show tag address (0x4) 

Value Type  int 

Default Value 0 
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Value 1/ min  No 

Value 2/ min Yes 

Via Application 

Menu 

Object by object through context menu ‘Tooltips’ 

Restart required Yes 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

IMG_MAX_FAST_ZONES 

Keywords Image 

Purpose Determines the limit of the number of fast zone 

bitmaps to be kept in a single window memory cache 

(least recently used bitmap is removed) 

Value Type  Numeric 

Default Value 0 

Value 1/ min  0 

Value 2/ min 7 

Via Application 

Menu 

Images -> (right) Properties -> Fast Zone -> 

Maximum fast zones 
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Restart required Yes 

 

 

IMG_MONO_FONT_H 

Keywords Font Image 

Purpose Controls the height for monospace fonts 

Value Type  Numeric 

Default Value 1000 

Value 1/ min  14 

Value 2/ min 1000 

Notes This parameter applies to the Chinese and Japanese 

versions. 

Restart required Yes 

 

IMG_MONO_FONT_W 

Keywords Font Image 

Purpose Controls the width for monospace fonts 

Value Type  Numeric 

Default Value 1000 

Value 1/ min  14 

Value 2/ min 1000 

Notes This parameter applies to the Chinese and Japanese 

versions  

Restart required Yes 
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IMG_MULTI_SELECT_IF_ALL 

Keywords Image 

Purpose Selects the object within the image only if selection 

rectangle covers the entire object 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Notes The value NO selects an object that is only partially 

included within the selection rectangle 

Restart required Yes 

 

IMG_PARSEONLOAD 

Keywords Image network tag 

Purpose Enables parsing names of Network tags during 

loading of Images (disabling shortens image load 

time, but does not check validity of network tags) 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Via Application 

Menu 

Images -> (right) Properties -> Loading -> Parse 

each image when loading 

Restart required Yes 
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IMG_POOLSIZE 

Keywords Image space 

Purpose Sets the amount of memory available for image 

objects 

Value Type  Numeric 

Default Value 300 

Value 1/ min  60 

Value 2/ min 5000 

Via Application 

Menu 

Images -> (right) Properties -> Loading -> Images 

memory pool size 

Restart required Yes 

 

IMG_RESFACTOR 

Keywords Image 

Purpose Sets a global stretching or shrinking factor for all 

images (used to compensate images for resolution 

differences for hardware and operating systems) 

Value Type  Numeric 

Default Value 1 

Value 1/ min  0.1 

Value 2/ min 10 

Via Application 

Menu 

Images -> (right) Properties -> View -> Resolution 

factor 

Restart required Yes 
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IMG_SMALL_INPUT_BOX 

Keywords Image trigger 

Purpose Sets the trigger button object as the small input box 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Via Application 

Menu 

Images -> (right) Properties -> Trigger -> Trigger 

small input box 

Restart required No 

 

IMG_STOP_UPDATE_ON_TRG 

Keywords Image tag trigger 

Purpose Enables the image to stop updating values of tags 

while momentary trigger is executed 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 
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IMG_TRG_KEYPAD 

Keywords Image Trigger 

Purpose Enables using keypad for triggers requiring numeric 

data entry 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Restart required Yes 
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IMG_USE_SEPARATOR 

Keywords Image Tag 

Purpose Sets group symbol for digits (in thousands) for tag 

displays 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Notes The default grouping symbol for the operating 

system is used  

Restart required Yes 

 

 

IMGMAXWAIT 

Keywords Image wait 

Purpose Sets the maximum time interval (in milliseconds) to 

wait before updating an image 

Value Type  Numeric 

Default Value 2000 

Value 1/ min  0 

Value 2/ min --- 

Via Application 

Menu 

Images -> (right) Properties -> Rates -> Maximum 

Restart required Yes 
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IMGMINWAIT 

Keywords Image wait 

Purpose Sets the minimum time interval (in milliseconds) to 

wait before updating an image 

Value Type  Numeric 

Default Value 10 

Value 1/ min  1- 

Value 2/ min --- 

Via Application 

Menu 

Images -> (right) Properties -> Rates -> Minimum 

Restart required Yes 

 

 

IMGWIZMSGBUF 

Keywords Alarm buffer image space tag 

Purpose Determines the size (in messages) of the message 

buffer that images use to collapse tag/alarm 

notification messages received by WizPro 

Value Type  Numeric 

Default Value 20 

Value 1/ min  5 

Value 2/ min 500 

Via Application 

Menu 

Images -> (right) Properties -> Rates -> Size of the 

internal message buffer that images use to collapse 

tag/alarm notification messages 

Restart required Yes 
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IMG_BACKGROUND_R / IMG_BACKGROUND_G / 
IMG_BACKGROUND_B 

Keywords Tones of image background during image loading 

Purpose Use any combination of these to specify any colour 

needed for the background of the image during 

loading (may be useful when loading big files 

Value Type  Numeric 

Default Value Red: 255 Green: 255 Blue: 255 (i.e. White) 

Value 1/ min  0 

Value 2/ min 255 

Via Application 

Menu 

No 

Restart required Yes 

IMG_EXPAND_REFRESH_BOXIMG_EXPAND_REFRESH_BOXIMG_EXPAND_REFRESH_BOXIMG_EXPAND_REFRESH_BOX 
 

Keywords Image dynamic objects  

Purpose Increases the size of the selection box around 

dynamic text. This can be useful in situations where 

the edges of the previous text are still visible.  

Value Type  Numeric 

Default Value 0 

Value 1/ min  0 

Value 2/ min 20 

Via Application 

Menu 

No 

Restart required Yes 
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IMG_DYNLOOKUPSIZE 
 

Keywords Image dynamic objects  

Purpose Use this to control the maximum number of dynamic 

objects that can be included in an image. Only 

necessary to change this in extreme cases with 

large, complex images. Note that increasing the 

number will result in each image using more 

memory. 

Value Type  Numeric 

Default Value 140000 

Value 1/ min  140000 

Value 2/ min None – increasing too high will result in memory 

overload! 

Via Application 

Menu 

No 

Restart required Yes 

IMG_LOADING_SHOW_PROGRESS 
 

Keywords Image Loading  

Purpose Use this to control the maximum number of dynamic 

objects that can be included in an image. Only 

necessary to change this in extreme cases with 

large, complex images. Note that increasing the 

number will result in each image using more 

memory. 

Value Type  String 

Default Value YES 

Value 1/ min  NO 
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Value 2/ min YES 

Via Application 

Menu 

Yes (Image properties dialog box) 

Restart required Yes 

 

WIZPRO_ENGINEERING_NUMBER_OF_DIGITS_AFTER_SEPARATO
R 
 

Keywords WizPro  

Purpose When using an engineering conversion to modify 

raw tag values, you can use this parameter to decide 

how many digits to be placed after the decimal 

separator in the converted value. 

Value Type  Numeric 

Default Value 9 

Value 1/ min  0 

Value 2/ min NO limit 

Via Application 

Menu 

No 

Restart required Yes 

 
 

LGRBUFSIZE 

Keywords Buffer history space tag 

Purpose Determines the WizPro logger buffer size (in 

lines/records) for history files 

Value Type  Numeric 
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Default Value 256 

Value 1/ min  1 

Value 2/ min 2048 

Via Application 

Menu 

Tags -> (right) Properties -> Wizpro Logger -> Buffer 

size 

Restart required Yes 

 

 LGRFLSHTIME 

Keywords History Tag 

Purpose Modifies the number of records that WizPro logs 

(flushes) to history files on disk (in seconds) in one 

operation 

Value Type  Numeric 

Default Value 30 

Value 1/ min  1 

Value 2/ min 3600 

Via Application 

Menu 

Tags -> (right) Properties -> Wizpro Logger -> Flush 

rate 

Restart required Yes 

 LOGGER_TIMEOUT 

Keywords Event history start wait 

Purpose Determines the time interval (in seconds) that the 

logger waits during WizPro startup 

Value Type  Numeric 

Default Value 2 
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Value 1/ min  2 

Value 2/ min 10 

Restart required Yes 

 

LOGIN_TEXT 

Keywords Alarm event login 

Purpose Determines the text to appear for login alarms 

Value Type  Text 

Default Value --- 

Value 1/ min  Text 

Via Application 

Menu 

Alarms -> (right) Properties -> General -> Login 

Alarm Text 

Restart required Yes 
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LOGOUT_TEXT 

Keywords Alarm event logout 

Purpose Determines the text to appear for logout alarms 

Value Type  Text 

Default Value --- 

Value 1/ min  Text 

Via Application 

Menu 

Alarms -> (right) Properties -> General -> Logout 

Alarm Text 

Restart required No 

 

 

MLS_RELOAD_OPEN_ALARMS 

Keywords Alarm event 

Purpose Reloads alerts upon language switching 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Notes This parameter applies to version 7.6 and later 

versions 

Restart required Yes 
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NET_BROADCASTTIMEOUT 

Keywords Network wait 

Purpose Determines the time interval (in seconds) between 

sending broadcast signals. It is only used in specific 

situations (e.g. when a station is started before it is 

connected to the network). 

Value Type  Numeric 

Default Value 0 

Value 1/ min  0 

Value 2/ min 65535 

Restart required Yes 

 

NET_CHECKRETYRY 

Keywords Network wait 

Purpose Determines the time interval (in seconds) to wait 

between receiving messages from the host before 

the remote station pings the host 

Value Type  Numeric 

Default Value 3 

Value 1/ min  0 

Value 2/ min 1000 

Notes It is recommended that all stations on the network 

use the same value for this parameter. 

Restart required Yes 
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NET_CHECKTIMEOUT 

Keywords Network wait 

Purpose Determines the time interval (in seconds) to wait 

before beginning the network communication error-

checking cycle 

Value Type  Numeric 

Default Value 5 

Value 1/ min  2 

Value 2/ min 600 

Restart required Yes 

 

 

 NET_COM_ERR_POPUP 

Keywords Network popup 

Purpose Determines if to show a popup window to signal a 

communication failure 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Notes OR Network -> Network Properties -> Protocol -> 

Show popup window on communication errors 

Via Application 

Menu  

Application Network -> Protocol -> Show popup 

window on communication errors 

Restart required Yes 
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NET_COMMCHECK 

Keywords Network 

Purpose This parameter turns on/off the network 

communication checking mechanism 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 

 

NET_HOTBACKUP_ADDR 

Keywords Backup network 

Purpose Establishes the link between a master station and its 

backup station 

Value Type  Address 

Default Value --- 

Value 1/ min  TCP/IP address 

Value 2/ min TCP/IP address 

Notes OR Network -> Network Properties -> Backup -> 

Backup Properties -> TCP/IP address.  Master 

station shows Backup   

Via Application 

Menu 

  Application Network -> Backup -> Backup 

Properties -> TCP/IP address 

Restart required Yes 
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 NET_HOTBACKUP_MAXPAUSETIME 

Keywords Backup network wait 

Purpose Defines the time interval (in seconds) that a backup 

station should wait in pause mode before 

automatically assuming active station status 

Value Type  Numeric 

Default Value 60 

Value 1/ min  10 

Value 2/ min 3600 

Restart required Yes 

 

 
  

NET_HOTBACKUP_MODE 

Keywords Backup network 

Purpose Determines the hotbackup switching mode 

Value Type  Enumerated 

Default Value Auto 

Value 1/ min  Auto 

Value 2/ min Manual 

Value 3 Disabled 

Notes OR Network -> Network Properties -> Backup -> 

Hot-Backup mode.  The Backup station can only be 

manually activated by using the SetBackup mode 

API in an add-on. 

Via Application 

Menu 

Application Network -> Backup -> Hot-Backup mode 
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Restart required Yes 

 

NET_HOTBACKUP_UPDATE_STATION 

Keywords Backup network 

Purpose Determines which station (Master or Backup) should 

be updated from the other when re-establishing 

communication 

Value Type  Enumerated 

Default Value Backup 

Value 1/ min  Backup 

Value 2/ min Master 

Restart required Yes 

 

 NET_LAN_ADPTR_NUM 

Keywords Network 

Purpose Not used for current application configuration 

Restart required %%% 
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NET_MAXCHANGESDELAY 

Keywords Buffer network wait 

Purpose Determines the maximum number of messages that 

a source station accumulates before sending the 

data buffer to a target station 

Value Type  Numeric 

Default Value 48 

Value 1/ min  1 

Notes OR Network -> Network Properties -> General -> 

Message Control -> Maximum network changes 

delay 

Via Application 

Menu 

Via Application Menu  Application Network -> 

General -> Message Control -> Maximum network 

changes delay 

Restart required Yes 

NET_MAXTIMEDELAY 

Keywords Alarm network tag 

Purpose Determines the maximum time interval (in 

milliseconds) that a station delays before updating 

the other stations with tag and alarm changes 

Value Type  Numeric 

Default Value 1000 

Value 1/ min  50 

Value 2/ min Unlimited 

Notes OR Network -> Network Properties -> General -> 

Message Control -> Maximum network time delay 

Via Application 

Menu 

Application Network -> General -> Message Control 

-> Maximum network time delay 
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Restart required Yes 

 

NET_NOBROADCAST 

Keywords Network 

Purpose If this parameter appears in Wiztune.dat with YES 

value, than NO BROADCAST mode is set. In this 

mode a broadcast signal is not sent to any station 

Value Type  Enumerated 

Default Value No 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 

 

NET_PINGCHECK 

Keywords Network 

Purpose This parameter turns on/off checking remote stations 

with help of ping mechanism(ICMP packet) 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 
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NET_PINGRETRY 

Keywords Network 

Purpose This parameter sets the count of ping retries to 

check a station. After this count (of retries) a 

communication error will be recognized 

Value Type  Numeric 

Default Value 0 

Value 1/ min  0 

Value 2/ min 500 

Restart required Yes 

 

  

NET_PINGTIMEOUT 

Keywords Wait 

Purpose Sets the maximum time interval (in seconds) for the 

station to wait for a response to a ping 

Value Type  Numeric 

Default Value 3 

Value 1/ min  1 

Value 2/ min 500 

Restart required Yes 
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NET_PROTOCOL 

Keywords Network 

Purpose Selects the network protocol for the application 

Value Type  Enumerated 

Default Value NPITCP 

Value 1/ min  NPITCP 

Value 2/ min NPINTBS 

Notes OR Network -> Network Properties -> Protocol -> 

Protocol.  The possible values: NPINTBS (Netbios); 

NPITCP (TCP/IP) 

Via Application 

Menu 

Application Network -> Protocol -> Protocol 

Restart required Yes 

 

 NET_QUERY_ADD_TIMEOUT_RETRY 

Keywords Network 

Purpose This parameter defines the count of additional 

timeouts for an answer waiting in a remote station 

Value Type  Numeric 

Default Value 10 

Value 1/ min  1 

Value 2/ min 10 

Restart required Yes 
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NET_QUERY_TIMEOUT 

Keywords Network 

Purpose Sets the network query timeout in seconds 

Value Type  Numeric 

Default Value 6 

Value 1/ min  1 

Value 2/ min 60 

Notes OR Network -> Network Properties -> General -> 

Message Control -> Maximum network answer time 

delay 

Via Application 

Menu 

Application Network -> General -> Message Control 

-> Maximum network answer time delay 

Restart required Yes 

NETWORK 

Keywords Network wait 

Purpose Determines whether the application network module 

is activated to enable access to application stations 

on the network 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Notes OR Network -> Network Properties -> General -> 

Activate Network 

Via Application 

Menu 

Application Network -> General -> Activate Network 

Restart required Yes 
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NEW_DBF_DATE 

Keywords Date 

Purpose Not used for current application configuration 

Restart required Yes 

OLD_NET_USER_AUTH 

Keywords User management network 

Purpose If this parameter is set to YES stations with old 

versions have full authorization to perform 

operations on local stations.  When set to NO - there 

is no authorization 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 

 

PLUG_START_MESSAGE 

Keywords Alarm Start 

Purpose Determines whether to show the message of the 

demo model if the plug is not installed 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 
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Restart required Yes 

PREFIX_SPACE 

Keywords Format image space 

Purpose Determines if a digital display contains space for the 

"+" / "-" prefix 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 

  

PRINT_TO_RIGHT 

Keywords Print 

Purpose Enables report printing alignment to the left 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Notes This applies to the Israeli version 

Restart required Yes 
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PRINTER_FORMAT 

Keywords Format print 

Purpose Determines which printer format should be used: 

DOS (Printer) or WINDOWS (File) 

Value Type  Enumerated 

Default Value DOS 

Value 1/ min  DOS 

Value 2/ min Windows 

Restart required Yes 

  

PRINTER_LINE 

Keywords Print 

Purpose Deternines alarm message line width when sent to 

printer (Hebrew-enabled NT only) 

Value Type  Enumerated 

Default Value --- 

Value 1/ min  --- 

Value 2/ min Compressed 

Notes The default width is 130 characters; the compressed 

width is 94 characters 

Restart required Yes 

 

. 
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RECIPEPERGATE 

Keywords Recipe tag 

Purpose Enables the processing of values according to the 

tag associated with the appropriate address in the 

recipe block 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Via Application 

Menu 

  Model Recipes -> (right) Properties -> General -> 

Process each value according to its tag 

Restart required Yes 

 

SHOWDONEBAR 

Keywords Studio 

Purpose Determines if the Background processing dialog box 

can appear when large tasks are being executed 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Via Application 

Menu 

Application -> (right) Station Properties -> Show 

done bar 

Restart required Yes 
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STARTUP_RECIPE 

Keywords Recipe start 

Purpose Determines the name of a recipe that will be loaded 

during application startup 

Value Type  File name 

Default Value --- 

Value 1/ min  --- 

Notes The WizPro logger and alarm generator will be 

activated only after the specified recipe is loaded 

Via Application 

Menu 

Model Recipes -> (right) Properties -> General -> 

Startup Recipe 

Restart required Yes 

 TRG_ACTIVATE 

Keywords Image trigger 

Purpose Determines which trigger-object is activated when 

two objects are overlapping 

Value Type  Enumerated 

Default Value TOP 

Value 1/ min  TOP 

Value 2/ min Bottom 

Via Application 

Menu 

Images -> (right) Properties -> Trigger -> State 

Restart required Yes 
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TRG_FEEDBACK 

Keywords Image trigger 

Purpose Determines whether trigger objects are highlighted 

when the object is clicked and the mouse button held 

down 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Via Application 

Menu 

Images -> (right) Properties -> Trigger -> Highlight -> 

Trigger object 

Restart required Yes 

 

TRG_TEST_ON_MOVE 

Keywords Image trigger 

Purpose Determines whether the mouse pointer is highlighted 

when moved on top of an Image trigger object 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Via Application 

Menu 

Images -> (right) Properties -> Trigger -> Highlight -> 

Mouse pointer on triggers 

Restart required Yes 
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TRIGGER_BUTTONS_TIMEOUT 

Keywords Trigger wait 

Purpose Defines the time interval (in milliseconds) to make a 

selection after accessing a trigger button dialog, and 

before automatically closing button dialog 

Value Type  Numeric 

Default Value 20000 

Value 1/ min  0 

Value 2/ min 99999 

Restart required Yes 

 

VFI 

Keywords Format history 

Purpose Sets the format for tag history files by selecting the 

Virtual File Interface DLL 

Value Type  Enumerated 

Default Value VFI5FST, VFI5CB 

Value 1/ min  VFI5CB 

Value 2/ min VFI5FST 

Notes VFI5FST can be used only for tag history files.  Both 

values can be used simultaneously 

Via Application 

Menu 

Wiz  -> (right) Station Properties -> VFI -> Allows 

you to determine the format for history files by 

selecting Virtual File Interface 

Restart required Yes 
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TRG_VISKEY 

Keywords Trigger 

Purpose Not used for current application configuration 

Restart required %%% 

VFI_DAYS_PER_FILE 

Keywords Format history time 

Purpose Defines how many days of data will be archived into 

each history file 

Value Type  Numeric 

Default Value 1 

Value 1/ min  1 

Value 2/ min 49 

Restart required Yes 

VFI5FST_IDX_SEC 

Keywords Format history time 

Purpose Determines the time interval represented by a time 

index 

Value Type  Numeric 

Default Value 60 

Notes  A value of 60 represents 1 index per minute. 

(VFI5FST_IDX_SEC is the recommended 

parameter; VFI5FSTT_IDX_SEC is for backward 

compatibility only 

Restart required Yes 
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VFI5FST_NO_COMM_ERR 

Keywords Format history 

Purpose Disables writing communication errors to history 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Notes No, writes the errors to history. 

(VFI5FST_NO_COMM is the recommended 

parameter; VFI5FSTT_NO_COMM is for backward 

compatibility only 

Restart required Yes 

VFI5FST_MODE_TIMESTAMP 

Keywords Format history time 

Purpose Defines if VFIFST supports both sorted and unsorted 

time stamps 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Notes NO supports only sorted timestamps. 

(VFI5FST_MODE_TIMESTAMP is the 

recommended parameter) 

Restart required Yes 
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VFI5FST_PREV_NEXT_IGNORE_SET_VALUES 

Keywords history timestamp LF_PREV LF_NEXT 

SET_VALUES 

Purpose Define if Set values are taken into account in FSTT 

mode (VFI5FST_MODE_TIMESTAMP=Yes) when 

looking for PREV and NEXT values 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  No 

Value 2/ min Yes 

Notes Result in charts depends also of 

CHART_REPORT_USE_SET_VALUES 

Restart required Yes 

 

 VFI5FSTT_IDX_SEC 

Keywords Format history time 

Purpose Determines the time interval represented by a time 

index 

Value Type  Numeric 

Default Value 60 

Notes A value of 60 represents 1 index per minute. 

(VFI5FST_IDX_SEC is the recommended 

parameter; VFI5FSTT_IDX_SEC is for backward 

compatibility only 

Restart required Yes 
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VFI5FSTT_NO_COMM_ERR 

Keywords Format history 

Purpose Disables writing communication errors to history 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Notes No writes the errors to history. 

(VFI5FST_NO_COMM is the recommended 

parameter; VFI5FSTT_NO_COMM is for backward 

compatibility only 

Restart required Yes 

 

VFI5FSTT_WRITE_BACK 

Keywords Format history 

Purpose Defines if the VFIFST will make optimizations in the 

history files while reading them (writing back of next 

record pointers) 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Via Application 

Menu 

VFI5FST_WRITE_BACK is the recommended 

parameter; VFI5FSTT_WRITE_BACK is for 

backward 
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Restart required Yes 

 

VFI5FST_MAX_FILES_AHEAD_4_PREV 
 

Keywords Interpolation, Tag history 

Purpose Limit of days to search for the previous record in tag 

history. If not found there will be no interpolation 

before the first visible point in chart window. 

Value Type  Numeric (Number of days) 

Default Value 30 

Notes For performance issue, try to set a value lower than 

the default. 

0 means no interpolation. 

Restart required Yes 

 

 

VFI5FST_MAX_FILES_AHEAD 
 

Keywords Interpolation, Tag history 

Purpose Limit of days to search the next record in tag history. 

If not found there will be no interpolation after the 

last visible point in chart window. 

Value Type  Numeric (Number of days) 

Default Value 365 

Notes For performance issue, try to set a value lower than 

the default. 

0 means no interpolation 

Restart required Yes 
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WIL_DISK_HIGH_LIMIT 

Keywords Alarm event history space 

Purpose Defines the maximum disk space limit after which old 

history files are deleted 

Value Type  Numeric 

Default Value 97 

Value 1/ min  0 

Value 2/ min 100 

Restart required Yes 

 

 

WIL_DISK_LOW_LIMIT 

Keywords Alarm event history space start 

Purpose Defines the setpoint at which a warning message is 

generated concerning low free disk space 

Value Type  Numeric 

Default Value 75 

Value 1/ min  0 

Value 2/ min 100 

Restart required Yes 

 WIZ_DATE_FORMAT 

Keywords Date format 
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Purpose Defines the application date format 

Value Type  Numeric 

Default Value W 

Value 1/ min  1 See Notes 

Value 2/ min 6 See Notes 

Notes Six possible values: 1 - DDMMYY, 2 - MMDDYY,  3 - 

YYMMDD, 4 - DDMMYYYY, 5 - MMDDYYYY, 6 - 

YYYYMMDD 

Via Application 

Menu 

Application -> (right) Station Properties -> Date 

Format -> Date style 

Restart required Yes 
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WIZ_DATE_SEPARATOR 

Keywords Date format 

Purpose Defines the separator character for the application 

date format 

Value Type  Numeric 

Default Value 1 

Value 1/ min  1 See Notes 

Value 2/ min 3 See Notes 

Notes Three possible values: 1 - slash (/) , 2 - dot (.), 3 - 

dash (-) 

Via Application 

Menu 

Application -> (right) Station Properties -> Date 

Format -> Date separator 

Restart required Yes 

 WIZ_SHOWMMW 

Keywords Date format 

Purpose Determines whether to show the Quick Access bar 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  Yes 

Value 2/ min No 

Restart required Yes 
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WIZDDES_TOPIC_NAME 

Keywords Database format 

Purpose Defines the topic name for the dde address format 

(application/Gate'A1 or Wizcon!'A1) 

Value Type  Enumerated 

Default Value Gate 

Value 1/ min  Gate 

Value 2/ min Tag 

Restart required Yes 

 WIZNET_ANN_PROF_DIRECTORY 

Keywords Alarm directory event folder 

Purpose Defines the location of the Events Summary Profiles 

files relative to the web application root directory 

Value Type  Folder/directory name 

Default Value AnnPrf 

Value 1/ min  Folder/directory name 

Notes If the directory name is changed, run the application 

upgrade tool to save event summary profiles in this 

new directory. 

Via Application 

Menu 

Open the dialog “Set Default Paths” from menu item 

“Design -> Options -> Paths”. 

Set the field Event Summary Profiles (.wna):  

Restart required Yes 
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WIZNET_HIS_CACHE_DAYS 

Keywords History time trend 

Purpose Defines the maximum number of days of stored 

history files  

Value Type  Numeric 

Default Value 10 

Value 1/ min  1 

Value 2/ min 365 

Notes OR Web Application -> (right) Properties -> History -

> Cache Settings -> Cache the last 

Via Application 

Menu 

Trends Profiles -> (right) Properties -> History -> 

Cache Settings -> Cache the last 

Restart required Yes 

WIZNET_IMAGE_DIRECTORY 

Keywords Directory folder image 

Purpose Defines the location of the picture files relative to the 

web application root directory 

Value Type  Folder/directory name 

Default Value Pictures 

Value 1/ min  Folder/directory name 

Notes If the directory name is changed, run the application 

upgrade tool to save image profiles in this new 

directory. 

Via Application 

Menu 

Open the dialog “Set Default Paths” from menu item 

“Design -> Options -> Paths”. 

Set the field Pictures (.wnp):  

Restart required No 
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WIZNET_MAXCHANGEDELAY 

Keywords Network wait 

Purpose Defines the maximum number of messages 

accumulated by a source station before sending 

them to a client 

Value Type  Numeric 

Default Value 48 

Value 1/ min  1 

Value 2/ min 50 

Notes OR Network -> Network Properties -> Internet -> 

Maximum number of messages delayed 

Via Application 

Menu 

Application Network -> Internet -> Maximum number 

of messages delayed 

Restart required Yes 

 WIZNET_MAXTIMEDELAY 

Keywords Network wait 

Purpose Determines the maximum time interval (in 

milliseconds) that a station will delay before updating 

the other stations with tag and alarm changes 

Value Type  Numeric 

Default Value 1000 

Value 1/ min  50 

Value 2/ min 1000 

Notes OR Network -> Network Properties -> Internet -> 

Maximum time a message could be delayed 

Via Application 

Menu 

Application Network -> Internet -> Maximum time a 

message could be delayed 
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Restart required Yes 

WIZNET_MIN_FREE_DISK 

Keywords History space trend 

Purpose Defines the minimum amount of storage (in 

megabytes) reserved as free space 

Value Type  Numeric 

Default Value 20 

Value 1/ min  1 

Value 2/ min 1024 

Notes OR Web Application -> (right) Properties -> History -

> Cache Settings -> Keep at least 

Via Application 

Menu 

Trends Profiles -> (right) Properties -> History -> 

Cache Settings -> Keep at least 

Restart required Yes 

 

WIZNET_ROOT_DIRECTORY 

Keywords Directory folder network 

Purpose Defines the name of the root directory for application 

objects 

Value Type  Folder/directory name 

Default Value Docs 

Value 1/ min  Folder/directory name 

Notes If the directory name is changed, run the application 

upgrade tool to save applet profiles in this new 

directory and rebuild all HTML pages or copy the 

contents of the old directory to this new one. 
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Via Application 

Menu 

Open the dialog “Set Default Paths” from menu item 

“Design -> Options -> Paths”. 

Set the field Web Application Root Directory:  

Restart required No 

WIZNET_TREND_PROF_DIRECTORY 

Keywords Directory folder trend 

Purpose Defines the location of the Trend profiles files 

relative to the web application root directory 

Value Type  Folder/directory name 

Default Value TrendPrf 

Value 1/ min  Folder/directory name 

Notes If the directory name is changed, run the application 

upgrade tool to save trend profiles in this new 

directory. 

Via Application 

Menu 

Open the dialog “Set Default Paths” from menu item 

“Design -> Options -> Paths”. 

Set the field Trend Profiles (.wnt):  

Restart required No 

 

WIZPRO_VPI_ROUND 

Keywords Tag 

Purpose Modify values from VPI to prevent roundoff errors for 

float tag values 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 
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Restart required Yes 

 

WIZPLCRT_EXIT_ON_WIZCON_SHUTDOWN 

Keywords WizPLC 

Purpose Close WizPLC Runtime when Wizcon shutdowns 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Restart required Yes 

 

WIZPLC_SHOW_EXPORT_TAG 

Keywords WizPLC 

Purpose Propose to show the WizPLC export tool before 

launching the WizPLC Studio 

Value Type  Enumerated 

Default Value Yes 

Value 1/ min  No 

Value 2/ min Yes 

Restart required No 
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WIZPLC_PROJECT_NAME 

Keywords WizPLC 

Purpose Name of the last opened WizPLC project 

Value Type  Folder/directory name 

Default Value Empty string 

Restart required No 

WIZPLC_DRIVER_USE_REMOVED 

Keywords WizPLC 

Purpose Indicated that the Wizcon application has been 

converted to communicate with WizPLC 3.0 

Value Type  Enumerated 

Default Value No 

Value 1/ min  No 

Value 2/ min Yes 

Restart required Yes 

WIZSQL_INTERFACE 

Keywords SQL 

Purpose Defines the interface used to connect the data file 

Value Type  Enumerated 

Default Value Oracle 

Value 1/ min  Oracle 

Value 2/ min ODBC 

Restart required Yes 
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WIZSQL_ODBC_ATTRIBUTES 

Keywords SQL 

Purpose Defines the data source name 

Value Type  Text 

Default Value --- 

Value 1/ min  Name of data source 

Restart required Yes 

WIZSQL_ODBC_CODE 

Keywords SQL 

Purpose Not used for current application configuration 

Value Type  Enumerated 

Restart required Yes 
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WRITE_FORMAT 

Keywords Alarm event format 

Purpose Defines the format right-to-left (RTL) or left-to-right 

(LTR) applying to alert message strings in Hebrew-

enabled system 

Value Type  Enumerated 

Default Value LTR 

Value 1/ min  LTR 

Value 2/ min RTL 

Notes This parameter applies to the Israeli version 

Restart required Yes 

 

 ALERT_PRT_2_LINES  

Keywords Alarm event format print 

Purpose Enables alarm information to be printed on two lines: 

first line - title, timestamp, etc.; second line - alarm 

text 

Value Type  Enumerated 

Default Value No 

Value 1/ min No 

Value 2/ min  Yes 

Via Application 

Menu  

Events Summaries -> (right) Properties -> General -

> Show Force End User 

Restart required Yes 

 



 
 
 
 
 
   

                                                                                 
   Wizcon

®
 Supervisor™ WizTune User Guide  

ALERT_PRINTER_TARGET 

Keywords Alarm event print 

Purpose Defines the real target for alarm output which is to 

the printer or file 

Value Type  Enumerated 

Default Value Printer Name 

Value 1/ min Printer Name 

Value 2/ min  File Name 

Restart required Yes 

  

TREND_VERTICAL_POS 

Keywords HTML Trend properties 

Purpose  

Value Type  Enumerated 

Default Value YES 

Value 1/ min NO 

Value 2/ min  YES 

Restart required No 
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TREND_LABEL_TAG_DESC 

Keywords HTML Trend properties 

Purpose  

Value Type  Enumerated 

Default Value YES 

Value 1/ min NO 

Value 2/ min  YES 

Restart required No 

TREND_LABEL_TAG_DESC 

Keywords Alarm event print 

Purpose Defines the real target for alarm output which is to 

the printer or file 

Value Type  Enumerated 

Default Value Printer Name 

Value 1/ min Printer Name 

Value 2/ min  File Name 

Restart required Yes 
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ALERT_PRINTER_TARGET 

Keywords Alarm event print 

Purpose Defines the real target for alarm output which is to 

the printer or file 

Value Type  Enumerated 

Default Value Printer Name 

Value 1/ min Printer Name 

Value 2/ min  File Name 

Restart required Yes 

 

ANN_FONTNAME 

Keywords Event Summary 

Purpose Allows you to set the name of the font for the event 

summary. This parameter is no longer supported. 

Use the options available in the event summary. 

Value Type  String 

Default Value Arial 

Restart required Yes 
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AHP_WIDTH 

Keywords Event Summary 

Purpose Allows you to set the width of the window displaying 

the Alarm Help file (.AHP) when launching from the 

event summary. 

Value Type  Numeric 

Default Value 395 

Value 1/ min 200. Note that a value of -1 means that the window 

will occupy the full width of the screen. 

Value 2/ min  Any number, but will be limited to the size of the 

screen 

Restart required Yes 

 

AHP_HEIGHT 

Keywords Event Summary 

Purpose Allows you to set the height of the window displaying 

the Alarm Help file (.AHP) when launching from the 

event summary. 

Value Type  Numeric 

Default Value 262.  

Value 1/ min 200. Note that a value of -1 means that the window 

will occupy the full height of the screen. 

Value 2/ min  Any number, but will be limited to the size of the 

screen 

Restart required  
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WIZODBC_ENABLE 

Keywords ODBC History Logging 

Purpose Whether to enable ODBC logging of tag history 

Value Type  Enumerated 

Default Value NO 

Value 1/ min NO 

Value 2/ min  YES 

Restart required Yes 

 

WIZODBC_ENABLE_BACKUP 

Keywords ODBC History Logging 

Purpose If ODBC logging is enabled, use this parameter to 

store history into text files in the case of a 

communication error with the database. Please note 

that if there is a lengthy break, there may be a heavy 

CPU load when communication is re-established, 

particularly if there is a log of history to be logged. 

Value Type  Enumerated 

Default Value 0 

Value 1/ min 0 

Value 2/ min  1 

Restart required Yes 

 

DSN_NAME 

Keywords ODBC History Logging 
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Purpose The name of the ODBC data source for tag history  

logging 

Value Type  Text 

Restart required Yes 

 

CROSSTABLE_NAME 

Keywords ODBC History Logging 

Purpose Specifies the name of the table in the ODBC data 

source into which tag history will be cross-referenced 

to the Tag name. ODBC_ENABLE=YES must be set 

Value Type  Text 

Default Value TagDefinition 

Restart required Yes 

 

HISTABLE_NAME 

Keywords ODBC History Logging 

Purpose Specifies the name of the table in the ODBC data 

source into which tag history will be logged. 

ODBC_ENABLE=YES must be set 

Value Type  Text 

Default Value TagHistory 

Restart required Yes 

 

TAGNAME_LOGGING 

Keywords ODBC History Logging 

Purpose Whether to log the tag name in the ODBC data 

source 

Value Type  Enumerated 
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Default Value No 

Value 1/ min No 

Value 2/ min  Yes 

Restart required Yes 
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USER_MANAGEMENT_DATABASE 

Keywords User Management 

Purpose Specifies whether to use a local or central user 

management database (using SQL Server). 

Accessible from the User Management tab on the 

Station Properties dialog box. 

Value Type  Enumerated 

Default Value ACCESS 

Value 1/ min ACCESS 

Value 2/ min  SQL_SERVER 

Restart required Yes 

 

USER_MANAGEMENT_SERVER 

Keywords User Management 

Purpose The name of the server that hosts the central user 

management database. Accessible from the User 

Management tab on the Station Properties dialog 

box. 

Value Type  Text 

Restart required Yes 

 

UM_RECOMPACT_ON_DB_OPENED 

Keywords User Management WizUM Compacting 

Purpose Define if the WizUM.mdb must be compacted a 2
nd

 

time after the opening of the database. Database is 

already compacted before the opening of the 

database and this 2
nd

 compacting doesn’t have 

major effect. Activate it only if you have problems 

when opening your WizUM.mdb file. 

Value Type  Text 
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Default Value NO 

Value 1/ min NO 

Value 2/ min  YES 

Restart required Yes 

 

SQL_SERVER_OWNER 

Keywords User Management 

Purpose The name of the owner of the central user 

management database (SQL Server). Accessible 

from the User Management tab on the Station 

Properties dialog box. 

Value Type  Text 

Restart required Yes 

 

SQL_SERVER_PASSWORD 

Keywords User Management 

Purpose Specifies the password for the SQL Server database 

owner. Accessible from the User Management tab 

on the Station Properties dialog box. Password is 

crypt if SQL_SERVER_CRYPTED = Yes 

Value Type  Text 

Restart required Yes 

 

SQL_SERVER_CRYPTED  

Keywords User Management 

Purpose Specify if the password for the SQL Server database 

owner is crypt in wiztune  

Value Type  If key exists, it means Yes otherwise No 
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Restart required Yes 

 

UM_SYNCHRONIZE_DATABASE 

Keywords User Management 

Purpose Specifies whether you want to keep the local user 

management database synchronized with a central 

database based on SQL Server. Accessible from the 

User Management tab on the Station Properties 

dialog box. 

Value Type  Enumerated 

Default Value NO 

Value 1/ min NO 

Value 2/ min  YES 

Restart required Yes 
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UM_DATABASE_TO_SYNCHRONIZE 

Keywords User Management 

Purpose Specify whether to update the data in either the local 

Access database or the central SQL Server 

database. Accessible from the User Management 

tab on the Station Properties dialog box. 

Value Type  Enumerated 

Default Value ACCESS 

Value 1/ min ACCESS 

Value 2/ min  SQL_SERVER 

Restart required Yes 

 

UM_SHOW_DIALOG_ON_RECONNECT 

Keywords User Management 

Purpose You can choose to show a dialog box when the 

connection to the central user management 

database is restored after a connection failure. This 

box asks if you want to synchronize the databases. 

Wizcon Systems recommends that you do not 

activate this option  

Value Type  Enumerated 

Default Value NO 

Value 1/ min NO 

Value 2/ min  YES 

Restart required Yes 
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UM_SYNC_DELAY 

Keywords User Management 

Purpose The time (in milliseconds) between attempts to 

synchronize the local and central user management 

databases. This option is not supported. 

Value Type  Numeric 

Default Value 10000 

Restart required Yes 

 

WIZ_ENV_ERR_MAX_SIZE 

Keywords Error Logging 

Purpose Lets you specify the maximum size for the errors.dat 

file. If the size exceeds the specified maximum, the 

oldest content of the file will be deleted. Specified in 

Megabytes. Accessible from the Station Properties 

dialog box. 

Value Type  Numeric 

Default Value 10 

Value 1/ min 0 

Value 2/ min  4000 

Restart required Yes 
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WIZ_ENVHIS_ERR_MAX_SIZE 

Keywords Error Logging 

Purpose Lets you specify the maximum size for the errors file 

(the file that stores errors.dat files from earlier 

sessions). If the size exceeds the specified 

maximum, the oldest content of the file will be 

deleted. Specified in Megabytes. Accessible from the 

Station Properties dialog box. 

Value Type  Numeric 

Default Value 10 

Value 1/ min 0 

Value 2/ min  4000 

Restart required Yes 

 

WIZ_ENV_ERR_ERRHIS_SESSION_COUNT 

Keywords Error Logging 

Purpose The errors file stores errors.dat files from previous 

Wizcon sessions. Use this variable to limit the number 

of errors.dat files are stored in this file.  

Value Type  Numeric 

Default Value 5 

Value 1/ min 0 

Value 2/ min  1000 

Restart required Yes 
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WIZSYS_TIME_FORMAT 

Keywords System Tags 

Purpose Used to define how to represent the system tag, 

WIZSYS_Time 

Value Type  Enumerated 

Default Value dd dddd mmmm yy 

 

WIZNET_SEND_TIMEOUT 
Keywords Wizintserver send Timeout (in ms) 

Purpose Timeout in ms of the wizintserver send operation. If 
after this time the applets did not read the 
wizintserver message the applet will be 
disconnected. 

Value Type       Integer 

Default Value 120000 (=2 min.) 

Value 1/ min 1 

Value 2/ max       

Restart required Yes. 

  

NET_ENABLE_AUTOLOGOUT 
Keywords  Enable or not automatic logout in web applets. 

Purpose  Set to YES to Automatically logout users after a given 
time of inactivity. The inactivity time can be set through 
the parameter NET_AUTOLOGOUT_PERIOD 

Value Type        ENUMERATED 

Default Value  NO 

Value 1/ min  YES 

Value 2/ min      NO 

Restart required  yes 
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NET_AUTOLOGOUT_PERIOD 
Keywords  Set the inactivity period in min after which a logout is 

automatic performed in web applets. 
Purpose  This parameter is effective only when the parameter 

NET_ENABLE_AUTOLOGOUT is set to YES. 

Value Type        Integer 

Default Value  30 

Value 1/ min  1 

Value 2/ min      99999 (~ 3 months) 

Restart required  yes 

  

LOAD_IMAGE_SAME_WIN 
Keywords Load image in same browser window.  

Purpose When the fast action “Load Image” is set to YES the 
new image is loaded in the same applet. This 
decreases significantly the time to load images. 

Value Type       ENUMERATED 

Default Value NO 

Value 1/ min YES 

Value 2/ max     NO 

Restart required Yes. 

  

TREND_FONT_NAME 
Keywords Trend font name 

Purpose Enables to set font used in trend applet. 

Value Type       String 

Default Value Dialog 

Value 1/ min   

Value 2/ max       

Restart required Yes. 
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TREND_FONT_SIZE 
Keywords Trend font size 

Purpose Enables to set font size used in trend applet. 

Value Type       Integer 

Default Value 12 

Value 1/ min   

Value 2/ max       

Restart required Yes. 

  

CHECK_WEB_TAG_STATUS 
Keywords  Check web tag status. 

Purpose  Enable application to avoid checking the status of a 
tag list.  

Value Type        ENUMERATED 

Default Value  YES 

Value 1/ min  YES 

Value 2/ min      NO 

Restart required  yes 

  

WIZ_MLS_REBUILD_ALL 
Keywords  Multi-language support. 

Purpose  Forces the multi-language support database to be 
rebuilt when the application is started.  It updates the 
identifiers of all tag, alarm and image text strings. If you 
set the value to yes, the database will be rebuilt and 
the parameter is reset to NO when the application 
closes 

Value Type        ENUMERATED 

Default Value  NO 

Value 1/ min  YES 

Value 2/ min      NO 

Restart required  yes 
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USE_ONE_HIS_LANG 

Keywords  Multilanguage support 

Purpose Will set which language will be used to write alarm 
history 

Value Type        string 

Default Value  Not set 

Value 1/ min  

Value 2/ max      

Restart required  YES 
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SETFORGROUNDWINDOW_NT 
 

 

NET_RECEIVER_ERR_WAIT 

Keywords  Network 

Purpose Amount of milliseconds receiver thread will wait after 
error of buffer receiving before to call buffer receiving 
again. Can be used in network applications to 
prevent receiver thread from taking 100% CPU 

Value Type        number 

Default Value  not used 

Value 1/ min  1 

Value 2/ max     60000 

Restart required  YES 

 

Keywords  Viewport Window Foreground 

Purpose Change behavior of API WizSwitchToVp. 

In Windows 2000 default behavior is to make active window 
blinking. With help of this parameter active window will be 
opened in the foreground. 

Value 
Type       

 YES/NO 

Default 
Value 

 NO 

Value 1/ 
min 

  

Value 2/ 
max   

  

Restart 
required 

 YES 
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NET_RECEIVER_DISCONNECT_DELETED 

Keywords  Network 

Purpose If set to YES – remote station will be set to 
communication error after error of buffer receiving 

Value Type        YES/NO 

Default Value  NO 

Value 1/ min   

Value 2/ max      

Restart required  YES 

NET_RECEIVER_DELETE_LSN 

Keywords  Network 

Purpose LSN number (internal term) will be deleted during 
station disconnection. Used for advanced network 
tuning 

Value Type        YES/NO 

Default Value  NO 

Value 1/ min   

Value 2/ max      

Restart required  YES 
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RAS_THIS_HOST 

Keywords  Network RAS 

Purpose This parameter sets IP address of the current station 
when RAS is used. This IP address will be 
transferred to remote station as IP of current station 
and this IP will be used for communication 

Value Type       IP address, for example - 192.168.0.20 

Default Value  Not set 

Value 1/ min   

Value 2/ max     

Restart required YES 

 
 

 

RAS_REMOTE_HOST 

Keywords  Network 

Purpose Used to specify IP address of remote station to 
connect when RAS is used. This IP must be inserted 
in othernet.dat as well 

Value Type       IP address, for example - 192.168.0.20 

Default Value  Not set 

Value 1/ min   

Value 2/ max     

Restart required YES 
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NET_CHECKRETRY 

Keywords  Network 

Purpose Number of retries station will make before to declare 
communication error with remote station. Each retry 
is period of time equal to NET_CHECKTIMEOUT 
during which station must receive message from 
remote station. 

Value Type        number 

Default Value  3 

Value 1/ min  0 

Value 2/ max     1000 

Restart required  YES 

 

 

 

NET_REQ_TIMEOUT 

Keywords  Network 

Purpose Timeout (in milliseconds) for Wizcon applets that are 
waiting for Wizcon Web Server messages. 
 
When the timeout NET_REQ_TIMEOUT is reached 
the following message is displayed in the Java 
console : 
 
Did not receive any message 

 

Value Type        number 

Default Value 5000 

Value 1/ min  1 

Value 2/ max    No maximum 
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Restart required  YES. 

 

NET_SYNC_FLUSH 

Keywords  Network 

Purpose If set to YES, internal network flush function will wait 
until all network messages will be sent to remote 
station. Used for advanced network tuning 

Value Type        YES/NO 

Default Value NO 

Value 1/ min   

Value 2/ max     

Restart required YES 

 

 

 

NET_USE_CONNECT_PRIORITY 

Keywords  Network 

Purpose This parameter is used to define the order in which 
stations will connect each other. ASC – means lower 
station ID will connect to higher station ID. DSC – 
vice versa. Used for advanced network tuning 

Value Type        ASC/DSC 

Default Value  Not set 

Value 1/ min   

Value 2/ max      

Restart required  YES 
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NET_HB_SWITCH_ACTIVE_TAG 

Keywords  Network 

Purpose Name of tag that will be set to 1 when switch to 
active mode is started and will be set to 2 when this 
switch is finished 

Value Type        Name of the tag 

Default Value  Not set 

Value 1/ min  

Value 2/ max      

Restart required  YES 

 

 

 

 

NET_HB_SWITCH_PASSIVE_TAG 

Keywords  Network 

Purpose Name of tag that will be set to 1 when switch to 
passive mode is started and will be set to 2 when 
this switch is finished 

Value Type        Name of the tag 

Default Value  Not set 
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Value 1/ min   

Value 2/ max     

Restart required  YES 

 
 

 

 

NET_HB_MANUAL_UPDATE_TAGS 

Keywords  Network 

Purpose If master backup is operating in manual mode and 
this parameter is set to NO station that is switching 
to passive mode will not request update of tag 
values from active stations.  

Value Type        YES/NO 

Default Value YES 

Value 1/ min   

Value 2/ max     

Restart required  YES 

 

 

 

NET_HB_MANUAL_UPDATE_ALARMS 

Keywords  Network 

Purpose If master backup is operating in manual mode and 
this parameter is set to NO station that is switching 
to passive mode will not request update of alarms 
from active stations.  
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Value Type        YES/NO 

Default Value YES 

Value 1/ min  

Value 2/ max     

Restart required  YES 

 
 

NET_BACKUP_INIT_TIMEOUT 

Keywords  Network 

Purpose Number of minutes that backup station will wait till 
complete initialization. If complete initialization is not 
finished during this period of time, backup station will 
not start mechanism for checking communication 
with master station. Used in big applications where 
number of tags and alarms is big (more than 10 
thousand) 

Value Type        number 

Default Value 1 

Value 1/ min 1 

Value 2/ max     120 

Restart required  YES 

 
 

 

ALERT_SAVE_LOCAL_UNACK 

Keywords  Alarms 

Purpose If this parameter is set to YES alarms from previous 
session (from lrm.dat) that are ended but not acked 
will not be deleted and will be presented in the 
system. By default local alarms (not from remote 
station and not system wide) that ended will be 
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deleted after restart 

Value Type        YES/NO 

Default Value NO 

Value 1/ min  

Value 2/ max     

Restart required  YES 

 
 

TAG_SAMPLE_ON_MON 

Keywords  Tags, Sampling 

Purpose If tag is defined with sampling in monitor and it was 
not read yet, setting this parameter to YES will force 
reading this tag when it goes into monitor 

Value Type        YES/NO 

Default Value NO 

Value 1/ min  

Value 2/ max     

Restart required  YES 

 
 

WRITE_TAG_BACK_TIME_DELAY 

Keywords  Tags 

Purpose 

This parameter is working together with 

WRITE_TAG_BACKWARD_TIMESTAMP. Time 

difference in seconds between tag timestamp and 

timestamp in the write value operation. If time 

difference more that defined by this parameter write 

operation will not check 



 
 
 
 
 
   

                                                                                 
   Wizcon

®
 Supervisor™ WizTune User Guide  

WRITE_TAG_BACKWARD_TIMESTAMP parameter 

 

Value Type        number 

Default Value 60 

Value 1/ min   

Value 2/ max     

Restart required  YES 
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WRITE_TAG_BACKWARD_TIMESTAMP 

Keywords Tag, OPC 

Purpose Write tag value operations with backward timestamp 
will not be performed. It was developed for OPC VPI. 

Value Type       YES/NO 

Default Value YES 

Value 1/ min   

Value 2/ max     

Restart required YES 

 
 

 

 

 

CHANGE_TAG_DEF_NO_PARSE_SAME_TAS 

Keywords  Tags, VPI 

Purpose If this parameter is set to YES tag address string will 
not be parsed in the driver during tag definition 
modification if it stills the same. 

Value Type        YES/NO 

Default Value NO 

Value 1/ min   

Value 2/ max     

Restart required  YES 
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VPI_SAMPLER_TIMEOUT 

Keywords  VPI 

Purpose Set number of 4 second units. Operations related to 
tag definition modification will wait this period of time 
for driver semaphore. Driver semaphore can be 
taken by sampler during read write operation. If this 
value is 0 timeout is infinit. 

Value Type        number 

Default Value 0 

Value 1/ min 0 

Value 2/ max     

Restart required  YES 

 

IPC_CALL_TIMEOUT 

Keywords  IPC 

Purpose Number of 4 second units. This period of time addon 
will wait for the return code of Wizcon API if it 
requires interprocess communication. 

Value Type        number 

Default Value  30 

Value 1/ min   

Value 2/ max      

Restart required  YES 
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TAGLOCK_SWITCH_TIMEOUT 

Keywords  Tag lock 

Purpose Number of milliseconds to wait between tag unlock 
and tag lock operation. 

Value Type        number 

Default Value 0 

Value 1/ min 0 

Value 2/ max      

Restart required  YES 

         

 

 

WIZ_DEBUG_DUMP_MODULES 

Keywords  Debug 

Purpose If set to YES will force to dump which libraries are 
loaded by wizpro.exe to wizpro-modules-dump.txt 
file 

Value Type        YES/NO 

Default Value NO 

Value 1/ min  

Value 2/ max     

Restart required  YES 
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VFI_ALARM_HIS_NO_FLUSH 

Keywords  Alarms 

Purpose If it set to YES flush functions will not be used after 
alarm history writing. Increase alarm performance 
but can cause to synchronization problem 

Value Type        YES/NO 

Default Value NO 

Value 1/ min  

Value 2/ max     

Restart required  YES 

 

 

 

 

 

 

 

 

 WIZPRO_DEBUG_FLAGS 

Keywords  Debug 

Purpose Set debug flags for wizpro, hexadecimal 

Value Type        Hexadecimal number 

Default Value  Not set 

Value 1/ min   
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Value 2/ max     

Restart required  YES 

 

 

 

 

    

 

SAMPLING_DURING_RECIPE_OPERATION 

Keywords  recipe 

Purpose If set to NO sampling will be disabled during recipe 
loading, saving 

Value Type        YES/NO 

Default Value  YES 

Value 1/ min   

Value 2/ max     

Restart required  NO 

 

          

         

 

 

 

 

 HB_PRINT_ALARMS_IN_PASSIVE_MODE 

Keywords  Network 

Purpose If set to NO it will not print alarms on backup passive 
station 

Value Type        YES/NO 
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Default Value YES 

Value 1/ min  

Value 2/ max     

Restart required  YES 

 

TIME_MASTER 

Keywords  Time 

Purpose If set to YES this station will act as time master for 
time synchronization. This means that all stations on 
the network will have their time synchronized with 
this station. 

Value Type        YES/NO 

Default Value  

Value 1/ min  

Value 2/ max     

Restart required  YES 

 

TIME_PRECISION 

Keywords  Time 

Purpose difference in number of seconds between time 
master and other station needed to start 
synchronization 

Value Type        number 

Default Value 5 

Value 1/ min 2 

Value 2/ max    60 
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Restart required  YES 
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TIME_SYNCH_PERIOD 

Keywords  Time 

Purpose Period of time (in hours) to check time difference 
between stations. every 20 seconds check for new 
stations on the network will be performed and they 
will be synchronized if needed 

Value Type        number 

Default Value 12 

Value 1/ min 1 

Value 2/ max    24 

Restart required  YES 

 

ALARM_DEF_ALLOC_BLOCK 

Keywords  Alarms 

Purpose Changes the allocation block size for alarm 
definitions. Can be useful if you experience problems 
when importing large numbers of alarms. 

Value Type        number 

Default Value 10240 

Value 1/ min 1024 

Value 2/ max    65535 

Restart required  YES 
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DDE_USE_READ_ONLY 

Keywords  DDE 

Purpose Allow to specify read only mode for tags defined in 
dummy driver with tag address string started from ‘R’ 

Value Type        YES/NO 

Default Value NO 

Value 1/ min  

Value 2/ max     

Restart required  YES 

 

DDE_USE_TAG_CONVERSION 

Keywords  DDE 

Purpose If this parameter is activated the tag conversion 
based on tag definition will be used 

Value Type        YES/NO 

Default Value NO 

Value 1/ min  

Value 2/ max     

Restart required  YES 
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DDE_NO_REQUEST_FIRST_VALUE 

Keywords  DDE 

Purpose If this parameter is activated first value will not be 
requested from the server during connect. It will 
increase startup performance in case of big number 
of tags with DDE 

Value Type        YES/NO 

Default Value NO 

Value 1/ min  

Value 2/ max     

Restart required  YES 

 

WIZRETAIN_SAVING_PERIOD_IN_SEC 
 

Keywords  Retain tags Start-up value 

Purpose Define the period for flushing values of retain tags 
into the WizRetain.dat file. If 0, the flushing is only 
done at Wizcon shutdowns. 

Value Type        Number 

Default Value 0 

Value 1/ min 0 

Value 2/ max     

Restart required  YES 
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WIZRETAIN_ON_COM_ERROR 

Keywords  Retain tags Start-up value 

Purpose Define what must be done when setting the start-up 
value of a Retain tag that was in Com. Error at last 
shutdowns. 0 means that the value is not set. 1 
means that the value is set with the latest valid 
value. 

Value Type        Number 

Default Value 0 

Value 1/ min 0 

Value 2/ max    1 

Restart required  YES 

 
 

AUTOLOGOFF_STUDIO 

Keywords  Automatic Logout 

Purpose If this value is set, then the user will be logged out 
from Wizcon studio after the given period of inactivity 
(no mouse movement or clicks and no key presses) 

Value Type        YES/NO 

Default Value NO 

Value 1/ min NO 

Value 2/ max    YES 

Restart required  YES 

 

AUTOLOGOFF_STUDIO_MAX_TIMEOUT 

Keywords  Automatic Logout 

Purpose The maximum time during which inactivity is allowed 
before the user is logged out (expressed in minutes) 
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Value Type        Number 

Default Value 2880  (i.e. 2 weeks) 

Value 1/ min 0 

Value 2/ max    65535 

Restart required  YES 

 

AUTOLOGOFF_STUDIO_TIMEOUT 

Keywords  Automatic Logout 

Purpose The time during which inactivity is allowed before the 
user is logged out (expressed in minutes) 

Value Type        Number 

Default Value 30 

Value 1/ min 0 

Value 2/ max    65535 (but depends on the maximum value of 
AUTOLOGOFF_STUDIO_MAX_TIMEOUT)  

Restart required  YES 

 
 

AUTOLOGOFF_STUDIO_CHECKING_FREQUENCY 

Keywords  Automatic Logout 

Purpose How often Wizcon will check for inactivity (expressed 
in secods). You should not need to change this 
value. 

Value Type        Number 

Default Value 1 

Value 1/ min 0 

Value 2/ max    65535 (but depends on the value of 



   
 
 
 
 

  Wizcon
®
 Supervisor™ Wiztune User Guide 

AUTOLOGOFF_STUDIO_TIMEOUT)  

Restart required  YES 

 
 
 
 

DISPLAY_NUMBER_OF_DIGITS_AFTER_SEPARATOR 
 

Keywords  Number of digits after separator 

Purpose Define the number of digits after separator which are 
displayed for float values in single tag value data box 
and in chart data box. The value is stored normally, 
without rounding.  

Value Type        Number 

Default Value 9 

Value 1/ min 0 

Value 2/ max     

Restart required  YES 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WIZPRO_ENGINEERING_NUMBER_OF_DIGITS_AFTER_SEPARATOR 
 

Keywords  Number of digits after separator 

Purpose Define the number of digits used after the separator 
for float values when the value is stored in Wizpro. 
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This parameter takes into account both float values 
and engineered values 

Value Type        Number 

Default Value 9 

Value 1/ min 0 

Value 2/ max     

Restart required  YES 

 
 


